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Thank you very much for purchasing this Sigma product.  
 
To receive maximum performance and enjoyment, and to not cause any injury or damage, 
please read this instruction manual carefully before using this product.  
 
Notices 
• Do not reproduce this manual in any form in whole or in part without prior permission. 
• The contents of this manual may be changed without notice. 
• Although we have made all possible efforts to produce a very accurate manual, if you find any 

mistakes, please contact our customer support. No liability can be accepted for any errors. 
• The specifications of this product are subject to change without notice. 
• SIGMA and its licensor do not accept any liability for any kind of results incurred as a result of 

software operation.   
 
In order to avoid causing any damage or injury, please read the following very carefully before 
using this product. 
 

 Warning !! 
Disregarding this warning sign when using the product can 
result in serious injury or other dangerous results.  

 
 Warning !! 

 
Do not play the included CD-ROM(s) in an Audio CD-ROM player. Listening the included CD-
ROM with headphones on a music CD player can cause hearing losses. Playing the included CD-
ROM on a music CD player could damage the speakers. 
 
The images recorded with this camera are intended strictly for personal use and should never be 
used in a way that infringes upon or contravenes international or domestic copyright laws and 
regulations. In addition, although it is intended purely for personal use, some restrictions may be 
applied to the photographing of demonstrations, performances, shows, exhibitions, or commercial 
properties, etc. Copyright or other legal rights should not be contravened. 

Trademark Acknowledgements 
� FOVEON is a registered trademark of Foveon, Inc. X3, and the X3 Logo are trademarks of 

Foveon, Inc. 
� Compact Flash is a trademark of SanDisk Corporation. 
� IBM PC/AT series computer and Microdrive are trademarks of International Business Machines 

(IBM) Corporation in the USA. 
� Microsoft and Windows are either registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries 
� Macintosh and FireWire are registered trademarks or trademarks of Apple Computer Inc. in the 

United States and/or other countries. 
� Adobe and Adobe Photoshop, are trademarks or registered trademarks of Adobe System 

Incorporated.  
� All other company or product names used in this document are trademarks or registered 

trademarks of their respective holders. 
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In this section you 
will learn… 
 
• The main features 

of SIGMA Photo Pro
 
• How this manual 

works  
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11..11  AAbboouutt  SSIIGGMMAA  PPhhoottoo  PPrroo    

What you can do in SIGMA Photo Pro; A quick visual tour 
Below are the windows and palettes found in SIGMA Photo Pro. Click on any window or palette to jump to 
a detailed view. 

  
  Main Window

 
 

• Copy images from camera to your computer 
• Save groups of images to TIFF or JPEG 
• Mark, lock, rotate, and delete images from 

camera or computer 

  
 
  

 

 
Image Information Window
• View capture information 
• View file information 
 

SIGMA Photo Pro User Guide 
 
 

Adjustment Controls Palette 
• Adjust image exposure compensation, 

contrast, shadow, highlight, sharpness and 
saturation 

• Adjust color 
• Load, save, and delete user-defined settings 
• View histogram 
• Set highlight and shadow warnings 
 

  
Review Window 
• View images at large size  
• Choose adjustment mode 
• Save images 
• Magnify details 
• View highlight and shadow 

warnings 
• Mark, lock, rotate, and 

delete images 
• Cycle through images 

displayed in the Main 
Window 

• Activate Adjustment 
Controls 

 
 
2 
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Main Window elements 
Below are the key elements found in the Main Window. Click on any link to take you to the section in the 
manual containing detailed descriptions.  
 
 
 

 

Click on the Copy Camera Images 
button p. 14 to copy X3F images 
from the camera to the computer 
 

 

Click on the Save Images As 
button p. 28 to process and 
save X3F images in TIFF or 
JPEG formats 
 

Click on the Info Button p. 41  
to open the Image Information 
Window 

e Edit Buttons p. 20 to 
rotate, mark, lock, or  
delete selected images 
 

Click on the Review Images button 
p. 22 to open a Review Window for 
viewing and adjusting an image 
 

 

The Computer Pa
folders on your co
the Computer Pan
 

SIGMA Photo Pro Use
Use Thumbnail Buttons p. 18 to control
the size and style of the thumbnails 
The Camera Pane p. 11 shows camera connectivity. 
Click anywhere in the Camera Pane to display 
camera images in the Thumbnail Pane Us
The Thumbnail Pane p. 18 displays 
images from your camera or from a 
selected folder on your computer 
 

ne p. 17 shows the drives and 
mputer. Click on a drive or folder in 
e to display images in a folder 

r Guide  3 
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Review Window elements 
Below are the key elements found in the Review Window. Click on any link to take you to the section in 
the manual containing detailed descriptions. 
Press the Navigation Buttons p. 23 to move forward 
and backward through images 
Press the Save Image As button p. 29 to 
process and save the X3F image in 
TIFF or JPEG format 

Click on the Info Button p. 41 to open 
the Image Information Window 

The Loupe p. 23 lets 
you view image details
 

Press Adjustment Controls p. 32 to 
open the Adjustment Controls Palette
 

Adjustment Modes p. 25 allow you  
to view images with different  
adjustment settings 
 

Use Edit Buttons p. 20  
to rotate, mark, lock,  
or delete, the currently  
displayed image 

SIGMA Photo Pro User Guide  4 
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11..22  AAbboouutt  tthhiiss  mmaannuuaall  
This manual provides information on the installation and use of SIGMA Photo Pro, the companion 
processing software for your SD9 digital camera.  
 

Symbols and conventions 
 

• Menu paths are denoted as follows: 

 Menu Header > Menu Choice 
 

• Keyboard Equivalents are shown as follows: 

Ctrl/Cmd + Letter or Symbol 
 
“Ctrl” is an abbreviation for the Control Key on a Windows system and “Cmd” is an abbreviation 
for the Command Key on a Macintosh system. 
 

 

Navigating the on-screen version of the manual 
To view the SIGMA Photo Pro manual while working in SIGMA Photo Pro, select Help > SIGMA Photo 
Pro Help from any window menu. 
 
The following features in the screen version of the PDF manual help you navigate and search quickly: 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 

Use the Search feature 
to find keywords 

Use the Bookmarks
feature to find main 
topics 

 
 
 

Use Links (underlined in blue) to 
jump to related topics  

SIGMA Photo Pro User Guide  5 
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In this section you 
will learn… 
 
• How to install 

SIGMA Photo Pro 
on your computer 

 
• How to set up your 

monitor 
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22..11  IInnssttaalllliinngg  tthhee  ssooffttwwaarree  

Windows system requirements 
If you are using your SD9 digital camera with a PC, the following minimum requirements are necessary to 
run SIGMA Photo Pro: 
  

• Pentium II 233MHz 
• Windows 98 Second Edition, Windows 2000, Windows ME, Window XP 
• 256MB RAM 
• 40MB of available hard disk space 
• 16-bit display card (24-bit recommended) 
• 800x600 monitor resolution (1024x768 recommended) 
• USB or IEEE 1394 (FireWire) connection 
• CD-ROM drive 

 

Macintosh system requirements… 
If you are using your SD9 digital camera with a Macintosh computer, the following minimum requirements 
are necessary to run SIGMA Photo Pro:  
 

• PowerPC G3 Processor 
• Mac OS 9.2.1 or Mac OS X v10.1.1 
• 256MB RAM OS 9 or 512MB RAM Mac OS X 
• 40MB of available hard disk space 
• 16-bit display card (24-bit recommended) 
• 800x600 monitor resolution (1024x768 recommended) 
• USB or IEEE 1394 (FireWire) connection 
• CD-ROM drive 
 

Installing and uninstalling software… 
To install SIGMA Photo Pro on your computer, insert the installation disk that shipped with your SD9 
camera. Double-click on the CD icon on your desktop. Then double-click on the Set Up (Windows) or 
Installer (Macintosh) icon to install the program. 
 

The Welcome Screen should appear on your screen. 
 
The wizard will take you through step-by-step instructions 
which will allow you to choose the language SIGMA 
Photo Pro displays on your computer, assign destination 
folders for the application, etc. 
 
You should close all other programs before running the 
installer, and you may need to reboot your computer once 
the program is installed. 
 
To uninstall the software in Windows, choose the 
Uninstall option from the SIGMA section of the Start 

Menu, or through the Add/Remove Programs option in the Control Panel. 
 
To uninstall the software on a Macintosh, double-click the Uninstaller icon in the SIGMA Photo Pro 
application folder. 

SIGMA Photo Pro User Guide  7 
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Installing camera drivers… 
A driver is necessary for your SD9 camera to communicate with SIGMA Photo Pro. On Macintosh, these 
drivers are automatically installed during the application installation. For Windows systems, it may be 
necessary to install these drivers using the Hardware Wizard. 

1) Verify that the camera is OFF. 

2) Plug the IEEE 1394 (FireWire™) or USB cable to the back of your computer and camera. 

3) Turn the camera on and wait for the Hardware Wizard to appear. 

4) Follow the Hardware Wizard instructions. When you are asked to specify a location for the 
appropriate driver, navigate to the location you installed SIGMA Photo Pro. In a typical 
installation, that path looks like: 

 C:\Program Files\SIGMA\Photo Pro\Drivers 

 You may need to specify this location several times in the course of installing the driver. 

5) Once you have specified the driver location, follow the remaining wizard instructions until you 
are prompted to click Finish. 

You may need to repeat this process for both USB and IEEE 1394 (FireWire™). 

Never connect the camera to the computer with both USB and IEEE 1394 (FireWire™) at the same time. 

SIGMA Photo Pro User Guide  8 
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22..22  SSeettttiinngg  uupp  yyoouurr  mmoonniittoorr  

Verifying monitor brightness, gamma, and color 
Making adjustments to your images on screen works best with a monitor that displays color consistently. 
Over time the characteristics of your monitor change, so check your monitor’s performance periodically. 
Consult your monitor documentation and perform calibration adjustments as recommended by the 
manufacturer. 
 
You can then verify monitor output from within SIGMA Photo Pro by selecting Tools > Monitor 
Verification… from the Main Window. 
 
 
The charts in this dialog box are for verification of color neutrality and gamma only. Use your monitor’s 
adjustment controls as specified in the manufacturer’s documentation to make any adjustments. 
 

Using a pre-existing 
monitor profile 
SIGMA Photo Pro supports 
monitor profiles. For 
information regarding monitor 
profiles, consult the 
documentation for your 
monitor, after-market profiling 
software, or operating system. 

 

Choosing the best monitor 
resolution for your screen 
size 
SIGMA Photo Pro is designed 
to fit on a monitor with a screen 
resolution of 800x600, however 
the viewable area for images 
and thumbnails is not 
maximized at this small screen 
size. A screen resolution of 
1024x768 or greater offers the 
most flexibility for viewing and 
processing images. You can 
then resize the Main or Review 
Windows, resize the Thumbnail 
Pane within the Main Window, 
or move the windows anywhere 
on the desktop. 
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In this section you 
will learn… 
 
• How to connect 

your camera to 
your computer 

 
• How to start up 

SIGMA Photo Pro 
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33..11  CCoonnnneeccttiinngg  tthhee  ccaammeerraa  ttoo  yyoouurr  ccoommppuutteerr  
When using SIGMA Photo Pro, only one SD9 digital camera should be connected at any given time. 
Disconnect any other digital cameras to assure the software operates correctly. 
 

Connecting the cables 
Before connecting the camera to your computer using either the USB cable or IEEE 1394 (FireWire™) 
cable, verify that the camera is turned off. Plug the cable into the computer and camera. Never connect 
the camera to the computer with both USB and IEEE 1394 (FireWire™) at the same time. 
 

Turning on the camera 
Turn the camera on as illustrated in your camera manual. SIGMA Photo Pro will not detect the camera 
unless it is turned on after being connected to the computer. 
 
At this point, you may be prompted to install a driver (p. 8) for the camera if it is the first time you 
have connected the SD9 to this computer.  
 
Once the camera is turned on and connected, SIGMA Photo Pro will auto-launch. The Main Window 
will appear with the Camera Pane highlighted in blue. Any images on the camera’s CF Card will be 
automatically displayed in the Thumbnail Pane. An empty Thumbnail Pane indicates no images were 
detected on the camera. 

 
 
 
 
 

 

The blue title bar indicates 
that the images on the 
camera are displayed in 
the Thumbnail Pane 

 

 

 

 

 

The
Car
con
 

 

 

 

Switching from battery to AC power 
It is recommended that you use AC power when connecting the camera to the com
power saves the camera batteries and avoids unsuccessful image transfer due to p

 
When you switch to AC power
will be replaced with the AC p
 
While using batteries, the batte
periodically as a reminder that 
draining. This is not necessaril
battery power. 
 

 

Connecting the camera while the application is running 
If SIGMA Photo Pro is already running and you connect the camera to your com
the camera will not be automatically displayed in the Main Window. If you wish 
images, select the camera by clicking on the Camera Pane.  

SIGMA Photo Pro User Guide  
The battery icon
indicates power 
source for the 
camera 
 camera and CF 
d icons indicate 
nectivity 

puter. Using AC 
ower loss.  

, the battery indicator 
ower indicator. 

ry icon will flash red 
the batteries are 
y an indication of low 

puter, the images on 
to display the camera 

11 



33     BB EE FF OO RR EE   YY OO UU   BB EE GG II NN    

33..22  LLaauunncchhiinngg  tthhee  ssooffttwwaarree  

Opening and closing SIGMA Photo Pro 
SIGMA Photo Pro will auto-launch and the Main Window will appear with the Camera Pane 
highlighted, whenever the camera is connected and then turned on. If no images appear in the 
Thumbnail Pane, this indicates no images were detected on the camera. 

 
You can launch SIGMA Photo Pro without connecting a camera by double-
clicking on the application icon on your desktop. The Main Window will appear 
and the last folder you worked in will be selected in the Computer Pane. Any 
X3F, JPEG, or TIFF images in this folder will be displayed. If this is the first 
time you are opening SIGMA Photo Pro, no folder will be selected. 
 
To exit the application, click on the close box in the title bar of the Main 
Window, or select File > Exit from the Main Window Menu. 

 

Enabling and disabling Auto-Launch 
SIGMA Photo Pro’s default condition is to auto-launch whenever the SD9 camera is detected. If you 
do not want SIGMA Photo Pro to launch each time you connect and turn on the camera, you can 
disable the preference by selecting Camera > Auto-Launch Setting… from the Main Window menu. 
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In this section you 
will learn… 
 
• How to copy 

images from your 
camera to your 
computer 

 
• How to erase the 

images from the 
CF Card as you 
copy 
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44..11  TTrraannssffeerrrriinngg  iimmaaggeess  ffrroomm  tthhee  ccaammeerraa  ttoo  yyoouurr  ccoommppuutteerr  

 

Using the Copy Camera Images button 
Transferring images from the camera to a folder on your computer assures that X3F files will be saved for 
future use. It also tags the images to identify which images have been transferred from the CF Card. This is 
useful when reviewing old images on the camera. You can also delete images from the CF Card as you 
transfer to free up space on your camera. 
 
To transfer X3F image files from the camera to your computer:  

1) Connect and turn on the camera. 
2) Select the Camera in the Main Window Navigation Pane.  
3) If you wish to transfer specific images only, select or mark the images. 

(Images marked on the camera remain marked when viewed in SIGMA Photo Pro.) 
4) Click on the Copy Camera Images button.  

 
The following dialog box will appear: 
 

 

Source:  
Choose images to be transferred by clicking a 
radio button for all, marked, or selected images. 
 

 

  

Using a CF Card reader to copy images to your 
If you have a CF card reader that can be displayed on yo
also recognize the drive in the Navigation Pane. You can
the CF Card to your computer; however, the X3F files w

SIGMA Photo Pro User Guide  
Transfer Option: 
Click in the checkmark box to delete images from
the CF Card after successful transfer to your 
computer. 
Destination: 
Click the Choose button to select a place on your 
computer to store the X3F images. 
 

Click OK to begin the transfer or Cancel to 
return to the Main Window 
 

computer 
ur computer as a drive, SIGMA Photo Pro may 
 use the CF Card reader to transfer images from 
ill not be tagged as transferred.
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In this section you 
will learn… 
 
• How to display, 

view, and sort 
images 

 
• How to select and 

move images  
 
• How to rename 

images 
 
• How to mark, lock,

and rotate images 
 
• How to delete 

images 
 
 

 Photo Pro User Guide  15 



55     MM AA NN AA GG II NN GG   II MM AA GG EE SS      

55..11  MMaaiinn  WWiinnddooww  OOvveerrvviieeww  

Main functions 
Go to the Main Window to do the following: 

• Copy images from the camera to your computer 
• View images as thumbnails 
• Process and save groups of images 
• Copy and move images to new folders 
• Rotate, mark or lock images 
• Rename or delete images 
• Access the Image Information Window 
• Open an image in a Review Window 

 
The Thumbnail Pane displays images directly from the camera when the Camera Pane is selected, or 
images from folders when the Computer Pane is selected. Note that the selected pane will be highlighted in 
blue. 
 
The Main Window is always open when working in SIGMA Photo Pro. Closing the window exits the 
program and closes any other open windows or palettes. 
 

Links to more information 
Click on any link below to view detailed descriptions of Main Window elements. 
 

 
 Process and save images 

Rotate, mark and lock images   
Copy images from camera 

  Open Review Window 

  

 

 
Camera 
Pane 
 
 
 
 
Computer 
Pane 

Change the look of 

SIGMA Photo Pro User Guide 
Image Info
thumbnails 

 

Delete
Thumbnail
Pane

Main Window 
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Changing the size of the Main Window 
Use the buttons in the title bar to maximize, minimize, and restore the size of your Main Window. You can 
drag the tab in the lower right hand corner of the window to any desired size.  

 

Changing the size of the Navigation and Thumbnail Panes 
To change the relative size of the Navigation and Thumbnail Panes, click and drag the 
splitter-bar located between the two panes. SIGMA Photo Pro will remember the new size 
the next time you launch the application.  
  
  
  
  
  Drag the gray bar left or right to change the size 

of the Navigation and Thumbnail Panes   
  
  
  

55..22  DDiissppllaayyiinngg  iimmaaggeess  iinn  tthhee  MMaaiinn  WWiinnddooww  

 

 

 

Viewing images stored on the camera 
Click on the Camera Pane to display camera images. The Camera Pane title 
will be highlighted and the images on the camera will be displayed in the 
Thumbnail Pane. 
 

View images stored on your computer 
Click on the Computer Pane to select the last folder viewed. The Computer 
Pane title will be highlighted and the images in the folder will appear in the 
Thumbnail Pane.  
 
Note: If the last folder viewed has been deleted, the Computer Pane will be 
highlighted, but no folder will be selected. 
 
Click on a drive or folder to select it. A gray band and an open folder icon 
indicates a selected folder. 
 
Double-click a folder to open it and reveal its sub-folders. 
 
Note: If  no images appear in the Thumbnail Pane, this indicates that no 
X3F images were detected on the camera, or no TIFF, JPEG, or X3F 
images were found in the selected folder. 
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55..33  DDiiffffeerreenntt  wwaayyss  ttoo  vviieeww  tthhuummbbnnaaiillss  

Changing the size and style of thumbnails 

 
Click on the Thumbnail buttons at the bottom of the Main Window to view thumbnails with or without text, 
and at different sizes. 
 
 

Small thumbnails 
Click on the button or select View > Small Thumbnails in the Main Window menu. 

Medium thumbnails 
Click on the button or select View > Medium Thumbnails in the Main Window menu. 

Large thumbnails 
Click on the button or select View > Large Thumbnails in the Main Window menu. 

Small thumbnails with details 
Click on the button or select View > Thumbnails with Details in the Main Window menu. 

    

 

 

 

  

Sorting and filtering thumbnails 
Sorting and filtering options for thumbnails are located under View in the Main Window menu. Use these 
selections or their keyboard equivalents to display specific groupings in the Thumbnail Pane. 

 
 
 
 
 

 

SIGMA Photo Pro User Guide 
View only X3F files in drive or folder 
(TIFF and JPEG files will not appear)
Choose to filter images that you have 
marked or locked 

 
Order images in the Thumbnail Pane
according to different attributes 
Reverse the order in which the thumbnails 
appear or Refresh the Thumbnail Pane view 

 18 



55     MM AA NN AA GG II NN GG   II MM AA GG EE SS      

55..44  RReennaammiinngg  IImmaaggeess  

Renaming images outside of SIGMA Photo Pro 
Changing the filename format (IMG#####) of an X3F file on a CF Card will make the file unreadable on 
the camera. Once copied to your computer, however, file names can be changed.  
 
On a PC, if you rename your files outside of the application, the file extension (.X3F) must be retained in 
order for the file to be recognized by SIGMA Photo Pro as the original. Processed files will have the file 
extensions .TIF and .JPG, and these two must not be changed. 
 
 

 
55..55  SSeelleeccttiinngg  iimmaaggeess  

Selecting one image 
Click once on a thumbnail to select an image. Double-clicking selects and then displays the image in a 
Review Window. Selected images are highlighted in yellow. 
 

Selecting multiple images 
Use the following conventions to select and deselect thumbnails using your mouse: 
 
• Shift + click on thumbnails for contiguous (range) selection  
• Ctrl/Cmd + click on thumbnails for non-contiguous (random) selection  
• Ctrl/Cmd + A to select all thumbnails 
• Click in an empty space or Ctrl/Cmd + D to deselect all thumbnails 
• Ctrl/Cmd + Shift + I to invert current selection of thumbnails 
 
 
The following Main Window menu selections and keyboard shortcuts are also available to select and 
deselect thumbnails: 
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55..66  MMaarrkkiinngg,,  LLoocckkiinngg,,  &&  RRoottaattiinngg  iimmaaggeess  iinn  MMaaiinn  aanndd  RReevviieeww  WWiinnddoowwss  
 

 
 

Rotating images 
Use the Rotate buttons to change the vertical or horizontal orientation of thumbnails. 
Images rotated on the camera will remain rotated after transferring to your computer.  
 

• Select images and click on the left Rotate button to rotate images to the left. 
• Click on the right Rotate button to rotate images to the right. 
• Only X3F images can be rotated. 
 

Marking and unmarking images 
Mark images when you want to identify groups of images for transferring, copying, processing, 
or moving. Images marked on the camera will remain marked after transferring to your computer.  
 

• Select one or more images and click the Mark button to mark. 
• Select one or more marked images and click the Mark button to unmark. 
• If a selected group has both marked and unmarked images, all images will be marked. 
• If all selected images are marked, clicking the Mark button will unmark the images. 
• Only X3F images can be marked. 
 

Locking and unlocking images 
Lock images to protect them from being accidentally deleted.  Images locked on the camera will 
remain locked after transferring to your computer.  
 

• Select one or more images and click the Lock button to lock. 
• Select one or more locked images and click the Lock button to unlock. 
• If a selected group has both locked and unlocked images, all images will be locked. 
• If all selected images are locked, clicking the Lock button will unlock the images. 
• JPEG, TIFF, and X3F images can be locked. 
  
55..77  DDeelleettiinngg  iimmaaggeess  iinn  tthhee  MMaaiinn  oorr  RReevviieeww  WWiinnddooww  

Deleting images 

 
• Select images and click on the Delete button or hit Delete on your keyboard. 
• The Delete dialog box will guide you through the deletion process. 
• Locked images must be unlocked before they can be deleted. 
• JPEG, TIFF, and X3F images can be deleted. 
• Images can also be recovered from your computer’s recycle bin or trash can. 
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In this section you 
will learn… 
 
• How to open a 

Review Window 
 
• How to view 

different images in
the Review 
Window 

 
• How to view 

details using the 
loupe 

 
• How to check 

shadows and 
highlights with the 
warning mask 

 
• How to use 

adjustment modes
 
• How to display 

multiple Review 
Windows 
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66..11  TThhee  RReevviieeww  WWiinnddooww  

Opening a Review Window 

 
You can display a Review Window on your desktop by double-clicking a thumbnail, or clicking on the 
Review Image button after selecting an image in the Main Window.  
 

Main functions 
Use the Review Window to do the following: 
 

• View individual images at a larger size and higher resolution 
• Process and save images individually 
• Review images with different adjustment settings 
• Access Adjustment Controls for custom processing 
• Mark, lock, rotate, or delete images 
• Navigate through other images on the camera or in a selected folder 
• Access the Image Information Window 

 

Links to more information 
Click on any link below to view detailed descriptions of  Review Window elements. 
 
 

  
Rotate, mark, and lock images View images with different adjustments 

Image Info Make custom adjustments   Delete

 

S

Process and save
images 
 View 
other 
images 

Review Window

IGMA Photo Pro User Guide 
Loupe
 22 
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66..22  NNaavviiggaattiinngg  tthhrroouugghh  aa  ffoollddeerr  uussiinngg  tthhee  RReevviieeww  WWiinnddooww  

Choosing which image is displayed in the Review Window 
When you open a Review Window, the first currently selected thumbnail is displayed. Double clicking on 
any thumbnail or selecting a thumbnail and clicking the Review Images button replaces the image in the 
open Review Window.  
 

Using Navigation Buttons to select images 
Click on the Review Window Navigation buttons to cycle through the other 
thumbnails displayed in the current Main Window.  You can also select View > 
Next image or Previous image from the Review Window menu. 
 

When the Previous button turns gray, it indicates you are viewing the first image in the folder. When the 
Next button turns gray, it indicates you are viewing the last image in the folder.  
 
Whenever you switch folders in the Main Window, both Navigation buttons will be disabled until you 
replace the image in the Review Window with an image from the new folder. 
 

Selecting specific images from the Main Window 
To view a specific image displayed in the Main Window, once you 
have already opened a Review Window, double-click on that 
thumbnail in the Main Window. The current image in the active 
Review Window will be replaced with the new image. 
 
  
  
  
  

  
  
66..33  UUssiinngg  tthhee  MMaaggnniiffiiccaattiioonn  LLoouuppee  

Turning the loupe on and off 
Click on the Magnification Loupe button to change the pointer to 
the loupe. Place the loupe over the image to magnify the area 
underneath. To turn off the loupe and restore the arrow, click on the 
button again.  

 

Changing the magnification of the loupe 
The loupe displays a magnified section of the image in the Review 
Window up to 800%. To change magnification, click on the left or 
right arrow buttons next to the Magnification Loupe button. The 
current magnification is displayed between the arrows.  
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How to read the RGB values in the loupe 
 
Three numbers are displayed in the lower right hand corner of the loupe which 
represent Red, Green, and Blue values in a 5-by-5-pixel sample in the center of 
the loupe.  
 
 
 
 
 

 

Restoring the loupe 
To restore the Magnification Loupe if the Color Adjustment 
Eyedropper is present, click on the Eyedropper button in the 
Adjustment Controls Palette. The indicator will be restored to its last 
state, either the loupe or a pointer.  
 
If a pointer is displayed, activate the loupe by clicking on the 
Magnification Loupe button in the Review Window. 
 
  

  
66..44  VViieewwiinngg  IImmaaggeess  wwiitthh  HHiigghhlliigghhtt  aanndd  SShhaaddooww  WWaarrnniinnggss    

Using masks to analyze highlights and shadows 
Red represents highlight areas exceeding the value set in the Histogram located in the Adjustment Controls 
Palette, and blue represents shadow areas below the value set in the Adjustment Controls Palette. See 
Section 8.4 for more information about the Highlight and Shadow Warning Mask. 
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66..55  UUssiinngg  tthhee  AAddjjuussttmmeenntt  MMooddee  SSeettttiinnggss  
Use the Adjustment Modes switch to control how X3F images are processed. When an X3F image is first 
displayed in the Review Window, a preview image is displayed. 

 
The indicator in the upper right corner of the Review Window animates while the 
image is processing. When the animation stops, the display will update to a higher 
resolution reflecting the current adjustment mode. 

 
To select a different mode, drag the blue ball to another adjustment mode or click on the desired mode. 

 

Default Mode: Reviewing images with default adjustments (to match in-camera preview) 
With Default selected, each image displayed in the Review 
Window will appear just as it was rendered on your SD9 digital 
camera, without further adjustment to tone scale or color.  
 
Default Mode remains selected until you choose another mode, or 
manually adjust a setting using Adjustment Controls. 

 
 

Auto Mode: Reviewing images with automatic adjustments (dependent on image content) 
With Auto selected, rendering settings are adjusted automatically 
for each image displayed.  
 
Auto Mode remains selected until you choose another mode, or 
manually adjust a setting using Adjustment Controls. 
 

To see what adjustments Auto is making, open the Adjustment Controls. Auto Mode sets these controls for 
each image automatically. If you want to further adjust the Auto settings, update any of the settings in the 
Adjustment Controls Palette. Notice that the Auto Mode is replaced with Custom. 
 

Custom Mode: Reviewing images with a specific setting applied 
With Custom selected, each image displayed in the Review 
Window will be rendered with the custom setting listed in the 
pop-down menu, or the current unsaved setting.  
 
The current setting in Custom Mode remains selected until you 
select another setting from the pop-down menu, choose another 
mode, or manually adjust a setting using Adjustment Controls. 

 
After selecting another mode, the last custom setting will remain in the pop-down menu. You can return to 
that setting by selecting Custom again. 
 

Unsaved Settings 
When “Current Unsaved Setting” is displayed in the pop-down menu, the adjustment settings reflect 
whatever is currently displayed in Adjustment Controls. 
 
 “Current Unsaved Setting” will instantly appear in the pop-down menu any time you manually adjust an 
image using Adjustment Controls. Moving controls or sliders automatically changes the mode to Custom, 
and “Current Unsaved Setting” will appear in the pop-down menu. 
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66..66  MMuullttiippllee  RReevviieeww  WWiinnddoowwss  

Opening Multiple Review Windows 
Having multiple Review Windows open lets you compare images or settings side-by-side. To display an 
additional Review Window, select File > Open New Review Window from the Main or Review Window 
menu. 
 
Once multiple Review Windows are open, double-clicking on any thumbnail in the Main Window will 
open the image in the topmost Review Window. 
 
Note: Each Review Window requires additional computer memory, so the program may run more slowly 
with multiple windows open. To optimize program performance, close Review Windows when not in use. 
 

Using multiple Review Windows to compare images 
Displaying similar images in two Review Windows side-by-side allows you to compare details such as 
composition, facial expressions, or focus before deciding which image you want to save.  
 

Using multiple Review Windows to compare modes 
Each Review Window retains its Adjustment Mode; any image displayed in the same Review Window will 
be processed using the retained Adjustment Mode. Displaying the same image in two different Review 
Windows side-by-side allows you to compare different modes. 
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In this section you
will learn… 
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and save images 
 
• How to apply 

adjustments 
 
• How to choose 

resolution, file 
type, and color 
space for your 
processed image
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77..11  MMaaiinn  WWiinnddooww  PPrroocceessssiinngg  

Processing groups of images simultaneously 

 
Processing groups of images in batches is a great way to quickly 
process X3F files which do not require individual attention. You will 
not be able to individually name the files, and all files must be 

processed using the same settings. However, if you select the Auto Adjustment Setting, SIGMA Photo Pro 
will optimize each image during processing. 
 
To process a batch of images: 

1) Select the folder containing the X3F images you wish to process. 
2) You can process the entire folder, selected images, or marked images. 
3) Select or mark specific thumbnails if desired. 
4) Click on the Save Images As button. 

 
The following dialog box appears: 
 
 
 
 

 

Source:  
Choose images to be processed by clicking a 
radio button for all, marked, or selected images.

 
 
 
  
  
  
  
  
  
  
  
  
  
  

Processing directly from the camera to the computer 
Processing and saving images directly from camera to computer
images in TIFF or JPEG format, bypassing the transfer of X3F f
files from the CF Card without transferring, sacrifices the benef
settings, resolutions, or file formats. However, processing direct
if you do not wish to process the images in the future, or have li

SIGMA Photo Pro User Guide  
Adjustment Mode: 
Choose Adjustment Mode for image
processing. 
Click OK to begin processing or Cancel to 
return to the Main Window. 

Destination: 
Click Choose to select a place on your 
computer to store the processed images.  

Processing Options:  
Choose Output file type 
 Resolution 
 Color Space 
 

 is the quickest way to obtain finished 
iles to your computer. Deleting the X3F 
it of reprocessing files using different 
ly from the camera is an appropriate option 
mited space on your computer. 
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77..22  RReevviieeww  WWiinnddooww  PPrroocceessssiinngg  

Processing individual images 
Processing an individual image from the Review Window is similar to processing from the Main Window, 
with the following added benefits: 
 

• Most of the processing is already done while you are viewing an image, so saving is quick 
• You can rename the processed file as it is saved 
• You can adjust settings using the Adjustment Controls Palette 
• You can review the image in more detail prior to choosing settings 

 
 

Once you have chosen the image to process, press the Save Image As 
button. 
 

 
The following dialog box appears: 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

Applying the current unsaved setting 
In addition to Auto, Default, and Saved Settings, you can also choose 
your image. This is useful if you do not wish to save the current unsav
 

Choosing a destination 
If you are processing from a folder where you transferred X3F images
source folder as an archive, or for future processing in a different size
source folder and the destination folder to be the same. 
 
 

SIGMA Photo Pro User Guide  
Source:  
The original capture resolution and filename 
are recorded here. This data cannot be changed.
 

Adjustment Mode: 
Reflects which Adjustment Mode is selected 
for image processing. 
 

Processing Options:  
Choose Output file type 
 Resolution 
 Color Space 
 

Destination: 
Click Choose to select a folder on your 
computer to store the processed images. You 
can also change the name of the processed file.
Click OK to begin processing and saving, or 
Cancel to return to the Main Window. 

the current unsaved setting to process 
ed setting. 

, those images will remain in the 
or format. It is not necessary for the 
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77..33  PPrroocceessssiinngg  ooppttiioonnss    
Use the pop-down menus and radio buttons to choose the processing settings to be applied to your image. 
Settings in the Main Window’s Save Image As dialog box are independent of the settings found in the 
Review Window’s Save Images As dialog box. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Color Space 
• PC Standard Color 
• Mac Standard Color 

 

File type 
8-bit TIFF, 16-bit TIFF, and JPEG file formats are supported by SI
appropriate file formats for different purposes, see Section 10.1. 

Resolution 
The default setting for resolution is the same as the resolution you s
your camera (High, Medium, or Low). You can also select one half
double the number of pixels in each dimension) for your processed 
Section 10.2. 

Adjustment Settings 
Three setting options are available: Default as rendered on the came
automatically by SIGMA Photo Pro, and Custom with adjustments 
how settings work, see Section 6.5. For information on saving settin

Color Space 
Selecting the correct color space according to your output needs all
to receive correct color data. If you do not have a specific color ma
that you choose either the PC or Mac standard color space. For mor
other color spaces in the pop-down field according to your needs.

SIGMA Photo Pro User Guide  
Output File Type
• 8-bit TIFF 
• 16-bit TIFF 
• JPEG

 

G

o
n

Resolution 
• Same as original capture size
• Half size 
• Double size 
e
,
i

s

e

Adjustment Mode 
• Default 
• Auto 
• Any other user defined setting 
MA Photo Pro. For information on 

lected when capturing the image on 
 or double the resolution (one half or 
mage. For more information, see 

ra, Auto with adjustments set 
et by the user. For more information on 
gs, see Section 8.6. 

ws other programs, printers, and users 
agement preference, it is recommended 
 specific color control, you can select 
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In this section you 
will learn… 
 
• How to use the 

Adjustment 
Controls palette 

 
• How to make tonal

adjustments 
 
• How to make color

adjustments 
 
• How to use the 

Histogram 
 
• How to set the 

Warning Masks 
 
• How to save 

settings 
 
• How to delete 

saved settings 
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88..11  UUssiinngg  AAddjjuussttmmeenntt  CCoonnttrroollss  ttoo  mmaannuuaallllyy  aaddjjuusstt  iimmaaggeess  
Adjustment Controls allow you to manually adjust the settings applied to images in the Review Window. 
Changing any control or slider places the current Review Window in Custom Mode (p. 25). The pop-down 
menu will show “CurrentUnsaved Setting” indicating that a control has been manually adjusted.  
 
Until you choose another mode or a saved setting, the current settings in the palette will be applied to each 
image appearing in the associated Review Window. When multiple Review Windows are open, the palette 
settings will reflect the current topmost active Review Window. 
 

Opening and closing the Adjustment Controls Palette 
To open Adjustment Controls, click on the Adjustment Controls button 
in the Review Window. 
  

 
 
 
 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Maximizing, minimizing, and closing the
To maximize or minimize a panel w
button in the upper right hand corne
Adjustment, Histogram, or Adjustm

  
Click the Close Box in the upper right
completely close the palette. Closing a

SIGMA Photo Pro User Guide 
Adjustment Mode p. 38 
Use to set the adjustment mode, and to save and delete specific 
adjustment settings 
Color Adjustment p. 34 
Use to neutralize and adjust overall color in your image 
 

Tonal Adjustments p. 33 
Use to adjust overall tone and color saturation 
 

Histogram p. 36 
Use to evaluate brightness values and assure the desired tonal range 
has been produced 
 palette 
ithin the Adjustment Controls Palette, click on the gray 
r of any of the four panels, Adjustment Controls, Color 
ent Mode. 

 hand corner of the Adjustment Controls Palette title bar to 
ll Review Windows will also cause the palette to close. 
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88..22  MMaakkiinngg  TToonnaall  AAddjjuussttmmeennttss  
Use the sliders to control exposure compensation, contrast, shadow, highlight, and saturation. To view the 
sliders, display the Adjustment Controls Palette on your screen, and maximize the panel titled Tonal 
Adjustments.  

 
Click the button to open and close the 
Slider Set Panel  

 
 
 

Click and drag the Numeric button to 
slide button to desired setting 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 

 

Exposure 
The Exposure Compensation slider affects the overall brightne
been changed. Use this control for slightly under or overexpos
represents 1/10 of an f/stop. The range of the Exposure Slider 
 

Contrast 
The Contrast slider affects the blackness of the blacks and the
Increasing the constrast brightens the whites and darkens the b
whites and the blacks. The range of the Contrast Slider is –2.0
 

Shadow 
The Shadow slider affects the blackness of the shadows. Incre
decreasing the number makes shadows darker. The range of th
 

Highlight 
The Highlight slider affects the brightness of the highlights. In
brighter, decreasing the number makes highlights darker. The 
 

Saturation 
The Saturation slider affects the intensity of the color in your 
color richer, decreasing the saturation makes the color weaker
2.0. The minimum saturation value of –2.0 corresponds to a pu
 

Sharpness 
The Sharpness slider affects the clarity of detail in your image
sharpness. The range of the Sharpness Slider is –2.0 to 2.0. 
 
SIGMA Photo Pro User Guide  
Click the Arrow buttons to change
slider settings in 1/10 increments 
Click the Reset button to restore 
sliders to default (no adjustment) 
settings 

ss of an image as if the original exposure had 
ed images. Each 1/10 increment of the slider 
is two stops in each direction. 

 whiteness of the whites with a single control. 
lacks. Decreasing the contrast grays both the 
 to 2.0. 

asing the number makes shadows lighter, 
e Shadow Slider is –2.0 to 2.0. 

creasing the number makes highlights 
range of the Highlight Slider is –2.0 to 2.0. 

image. Increasing the saturation makes the 
. The range of the Saturation Slider is –2.0 to 
re grayscale (Black and White) image. 

. The higher the number, the stronger the 
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88..33  MMaakkiinngg  CCoolloorr  AAddjjuussttmmeennttss  
Use Color Adjustment to change the overall color of your image. For example, if your image has an overall 
yellow tone caused by indoor lighting, adding cyan and magenta will remove the yellow color cast. 
 
You can manually adjust color using the Color Wheel; you slide the control to a desired effect, or you can 
use the Color Adjustment Eyedropper to automatically neutralize a scene based on a correction to a sample 
in a known neutral area where the present RGB values are not neutral. 
 
To view the Color Adjust Wheel, display the Adjustment Controls Palette on your screen, and maximize 
the panel titled Color Adjustment. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Click the button to open 
and close the Color 
Adjustment panel 
 

 

 
 
 

Click the Reset button to restore color 
adjustments to default (no adjustment)
settings 
 
 The eyedropper button 
 
 The Cyan, Magenta, and Yellow valuesdisplayed in “CC” (color correction 

filter units)represent the color adjustment represented by the target ring 
 

 
 

 

Using the Color Wheel 
 
Click and drag the target ring anywhere in the colored portion of the circle. As you move to the edge of the 
color wheel, the color in the image will become more intense in that range. Moving outside of the circle 
will continue to produce color changes even when the target ring is no longer in view. 
 
To return the image to the original default settings, click on the Reset button. 

 

 

 
 

 
 
 
 
 
 
 

Increasing an additive primary
color (red, green, or blue)

decreases its
complementary color

(cyan, magenta, or yellow)
 
 

Increasing a subtractive primary color  
(cyan, magenta, or yellow) 
decreases its  
complementary color 
(red, green, or blue)  
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Using the Color Wheel to manually adjust color 
To manually neutralize a color cast, such as a yellow scene caused by indoor lighting, use the loupe in the 
Review Window to sample a color that represents a neutral gray. Based on the RGB values in the loupe, 
drag the target ring in the color wheel to set the CMY values so that the RGB values will equalize. Since 
the sampled color was known to be neutral, this generally balances the overall color of the image. 
 
The value of the target ring is represented by units of cyan, magenta, and yellow recorded below the color 
wheel, displayed in “CC” (color correction filter units). The chart on the preceding page indicates the 
relationship between red, green, and blue, and cyan, magenta, and yellow. 
 
If you feel the image has an overall color cast, and do not have a neutral color to sample, drag the target 
ring in the opposite direction of the unwanted color to neutralize. For example, if the image appears too red, 
move the target ring towards cyan, on the opposite side of red in the Color Wheel. 
 
 

Using the Color Adjustment Eyedropper to adjust color 
 

Use the Color Adjustment Eyedropper to let SIGMA Photo Pro create neutral gray tones in your 
image. Locate a portion of your image in the current Review Window that includes a known 
neutral color that is not rendered as a neutral color. Click on the eyedropper button. The pointer 
turns to an eyedropper.  

 

Before  

After adjustme 
 
 
If you are viewing the image in the Review Wind
neutral area are exactly equal to each other, or ne
 
If you wish to redo the gray balance using a diffe
repeat the steps above. 
 
If you do not like the results of the color adjustm
return to default (no color adjustment) setting. Y
then move the target ring in the color wheel to re
 

SIGMA Photo Pro User Guide 
Place the eyedropper over the color to be neutralized and click. 
The software will evaluate that sample and make adjustments 
to achieve a neutral tone.  You can also click and drag the color 
picker and the software will continue to sample and adjust until 
you release the mouse. 
 

Once you have clicked on the neutral 
tone, click the eyedropper button to 
return to the original loupe or pointer.  
 
Note in this example that the known 
neutral gray square was weak in Red. 
Once balanced, the Red value increased 
from 93 to 101, and the gray now 
appears neutral as in the original scene. 

nt 

ow using the loupe, notice that the RGB values in the 
arly exact, after the adjustment.  

rent sample point, click on the eyedropper button and 

ent, click on the Reset button at the bottom of the panel to 
ou can also use the eyedropper adjustment as a base, and 
fine your adjustment. 
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88..44  UUssiinngg  tthhee  HHiissttooggrraamm  aanndd  WWaarrnniinngg  MMaasskkss  

Reading the Histogram 
To view the Histogram, display the Adjustment Controls Palette on your screen, and open the panel titled 
Histogram. 
 

Click the button to 
open and close the 
Histogram Panel 
 

 

Turn the warning 
masks on and off 
by clicking on the 
checkmark box 

 

 

 

 Click on arrows to set 
the shadow and 
highlight values for the 
warning masks 
 

 

 

 
The Histogram graphically displays the distribution of brightness values in your image. There are three 
readouts depicted as colored lines which each represent the brightness values of the Red, Green, and Blue 
channels. These represent the same RGB values you see individually recorded in the lower right hand 
corner of the loupe in the Review Window.  
 
Shadows are represented on the left side of the graph, mid-tones in the center, and highlights on the right 
side of the graph. The scale in which these values are measured is between 0 (blackest shadow) and 255 
(whitest highlight).  
 

Enabling, disabling and setting values for the Warning Masks 
To turn the warning masks on and off click the checkmark box at the bottom of the Histogram panel. You 
can set the values in the warning mask to alert you when a shadow or highlight value on one or more of the 
channels falls outside of the specified values. 
  
For example, you may discover that your printer or color lab cannot produce good shadow detail when 
values fall below 8, and that highlights appear blown out above the value 240. With this information, you 
can set the warning mask to 
alert you when the values 
exceed these limits. To set the 
limits, click on the arrow 
buttons below the histogram 
until the shadow and highlight 
values are set. 
 
Once you have set the values 
for the mask, you can manually 
adjust the sliders in the 
Adjustment Controls Palette 
until the warnings are reduced 
or eliminated. Below is an 
example of a Review Window 
with the Warning Mask 
enabled. This powerful feature 
helps you to best use the tonal 
range for your finished print. 
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88..55  CChhaannggiinngg  WWhhiittee  BBaallaannccee  

Changing the White Balance setting on an X3F file 
White Balance can be adjusted during processing. If you wish to change the lighting type for a particular 
image, you can change the lighting type to match any of the lighting types featured on your SD9 camera. 
To change White Balance, first select the image you wish to change in a Review Window. Next select Edit 
> White Balance from the Review Window menu. The following dialog box will appear: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The current White Balance setting will appear in the input field. To select a different White Balance setting, 
choose from the pop-down menu. For more information about specific White Balance settings, consult your 
SD9 camera manual. 
 
When you select a different White Balance setting, the original X3F file will be modified with the updated 
information. The thumbnail image in the Main Window, and the preview image in the Review Window 
will not appear to change. The new White Balance setting will be applied during processing, and its effects 
will appear in the Review Window after processing is complete. 
 
Each time you select a different White Balance setting, the new setting will be automatically saved to the 
X3F file. To view the effect of the change, wait for the image to complete processing. 
 
If the feature is disabled in the menu when you access it from the Edit Menu, check to see where your X3F 
image is stored. Since the White Balance feature moidifies the original X3F file, the feature will be 
disabled when the image is located on read-only media such as a CD. 
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88..66  SSaavviinngg  aanndd  aappppllyyiinngg  ccuussttoomm  sseettttiinnggss  

Applying settings from the Adjustment Controls Palette 
To view the Adjustment Mode, display the Adjustment Controls Palette on your screen, and open the panel 
titled Adjustment Mode. 
 
The Adjustment Mode settings in the Adjustment Control Palette reflect the same information as the 
Adjustment Mode settings found in the active Review Window. See Page 25 for a review of this 
information.   
 
 

Click the button to open and close 
the Adjustment Mode Panel 

 

Click the Save Button to save the 
current settings in the Adjustment 
Control Palette. Click the Delete 
Button to remove saved settings no 
longer needed. 

 
 
 

Saving settings 
 
To save the current setting in the Adjustment Control Palette, click on the Save Setting button located at the 
bottom of the Adjustment Mode Panel. The Save Setting dialog box will appear.  
 
Type in a name for your new setting in the input field. To update an existing saved setting, click on the 
name of the setting you wish to update. Click Save. 
 

Deleting settings 
 
To delete a saved setting, click on the Delete Setting button located at the bottom of the Adjustment Mode 
Panel. The Delete Setting dialog box will appear.  
 
Click on the name of the setting you wish to delete and click Delete. 
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In this section you 
will learn… 
 
• How to find image

info in the Main 
and Review 
Windows 

 
• How to open an 

Image Info 
Window for 
additional 
information  
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99..11  IImmaaggee  iinnffoorrmmaattiioonn  

Image information in the Main and Review Windows 

 
When a single image is selected in the Main Window, basic information about the image appears above the 
Thumbnail Pane in an information field. When multiple images are selected, the Main Window information 
field will be blank. 
 
Information includes: 

• Filename 
• Date and time of image capture 
• Aperture, shutter speed 
• ISO, resolution 
• File size in megabytes (MB) 

 
The same information field appears above the image pane in the Review Window. 

 
In addition to text information, single images will also display icons in the information field 
indicating marked status, locked status, and transfer status.  If the selected image is a TIFF 

or JPEG processed outside of SIGMA Photo Pro, information is limited to file type and locked status icons 
only. 
 
 

Image information in the Thumbnail Pane 

 
Information about selected images is located in the information field at the bottom of the Thumbnail Pane 
in the Main Window. The field indicates how many images are selected and how many MB in total the 
selected images use.  
 

Image information in the Camera and Computer Panes 
 

Similar information is located in fields below the Camera Pane and the 
Computer Pane. Information includes how many images are presently in the 
folder or on the camera, and the total MB used.  
 
 
 
 
 
 
 

 

  
Information Field 
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  99..22  AAcccceessssiinngg  tthhee  IImmaaggee  IInnffoorrmmaattiioonn  WWiinnddooww  
 

 

The Image Info Button 
You can view additional information about individual images or groups of selected images by clicking the 
Image Info button in the Main or Review Window. 
 

The Image Information Window 
The Image Information Window describes the selected image(s) in the Main or Review Window. One of 
the Image Information Windows pictured below will be displayed on your screen, depending on the 
number of images you have selected.  
 
  
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To get information for a different image, click on the Review Window containing the new image or on a 
new thumbnail in the Main Window. The Image Information Window will update with information about 
the selected image. 
 
The Image Information Window remains open and floats above the Main and Review Windows until you 
close it, or until you exit the program. To close an Image Information Window without exiting SIGMA 
Photo Pro, click on the Close button in the Title Bar or on the Close button at the bottom of the window. 
 

To copy the text in the Image Information Window, click on the Copy 
to Clipboard button. Paste the text into any word processing program. 
Then you can use the word processing program’s print function to 

print the text. If you choose to save these text files in your SIGMA Photo Pro image folders for easy access 
later, note that they will not be visible from within SIGMA Photo Pro, but you can continue to open and 
print them from your word processing application. 
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1100..11  SSuuppppoorrtteedd  ffiillee  ttyyppeess  

TIFF format 
TIFF (Tagged Image File Format) images are high quality bitmapped images widely recognized by many 
programs. This bitmapped file format is the industry standard, and images in this format are created without 
color compression. Without compression, file size is large, but TIFFs are a good choice when you desire 
high quality and uncompromised color. 
 

8-bit versus 16-bit TIFFs 
The number of bits per pixel in a bitmapped image represents the range of possible values that an image 
can have. With a greater range of possible colors, images can be rendered with less banding and 
posterization as bit-depth increases. Greater bit-depth directly correlates to file size, so a 16-bit TIFF 
requires twice the memory as an 8-bit file. 
 
Before choosing 16-bit files, check to see if your output device and color software support 16-bit TIFFs. If 
you do not plan to do extensive color correction and compositing, 8-bit files may be sufficient for your 
needs. 
 

JPEG format 
JPEG images are images which are compressed in file size for rapid loading via email or on the web, or for 
hard disk storage efficiency. These files achieve this file size reduction through the compression of color. 
You can control the amount of compression via a slider control in SIGMA Photo Pro when you save the 
file. The more you compress the image, the more likely you will be to see banding and posterization in the 
image. 
 
JPEGs are a good choice for images which will be displayed on the web because the file size is small. 
Without reducing resolution, images can be saved in a format which loads quickly on screen. For high 
quality prints however, results may be compromised as the quality setting of the JPEG is lowered. 
 
If you open and adjust a JPEG repeatedly using image processing software, it should also be noted that any 
adverse effects of the compression are cumulative. That is to say, if you make changes, save, and close 
several times, each time you save the JPEG, additional data is lost in the compression. 
 

Deciding which format to use 
JPEGs are a great way to make fast loading efficient files. If you are in the practice of saving your X3F 
files, you can take advantage of JPEG compression for efficient web–email files. Later, you can use the 
original X3F files to create high quality TIFFs should the need arise for high quality prints. 
  
1100..22    CChhoooossiinngg  rreessoolluuttiioonn  

Choosing resolution 
Resolution refers to how many pixels per inch an image contains. This directly affects how big an image 
will be output on a printer or monitor. Because printers require more pixels per inch (typically 300 ppi or 
greater), choose larger resolutions when shooting and processing images which will be printed. Because 
monitors require less pixels per inch (typically 72 to 96 ppi), choose lower resolutions when shooting or 
printing when the image will be used exclusively for display on a monitor via email or the web. 
 
When your image will be used for both print and monitor display, shoot and process the image at a high 
resolution for the print version. For the email–web version, you can use image processing software to save 
an additional copy from the processed file, and resample the copy to a smaller size by reducing the 
resolution. In general, software designed to resample (change resolution) works best when reducing 
resolution (downsampling). Resampling to a higher resolution (upsampling) is possible, but the results are 
not as crisp. Whenever you need to upsample, it is recommended that you re-process your X3F file using 
the highest resolution options. 
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1100..33  CCaammeerraa  rreeffeerreenncceess  

Setting camera date and time 
You can set the camera date and time to match the date and time on your computer system. First confirm 
that the date and time on your computer is correct. See your computer’s documentation for instructions. To 
set the camera’s date and time, connect the camera to your computer and verify that the camera is turned 
on. From the Main Window menu select: 
 

Camera > Set Camera Date and Time 
 
Click OK to set the date and time. Click cancel to cancel the operation and leave the camera date and time 
unchanged. 
 

 

Battery warnings 
Loss of  battery power is instant, so it is always recommended to connect the camera to AC power when 
connecting your camera to your computer to avoid any loss of data. As a reminder, when the camera is 
connected to the computer using battery power, the battery icon will flash red repeatedly periodically. This 
is only an indication that battery power is being used, and not an indication that the camera batteries are 
low in power. Loss of digital battery power can be instant or gradual. 

SIGMA Photo Pro User Guide  44 





II NN DD EE XX    

IInnddeexx  
A 
Adjustment Controls Palette......................32 
Adjustment Modes ....................................25 
 Default .................................................25 
 Auto .....................................................25 
 Custom.................................................25 
Auto-Launch..............................................12 
Auto Mode.................................................25 
 
C 
Camera ................................................11, 44 
 Battery warning....................................44 
 Connecting ...........................................11 
 Setting date and time............................44 
Color.................................................... 34-35 
 Adding and removing..................... 34-35 
 Adjusting........................................ 34-35 
Contrast .....................................................33 
Copying Images.........................................14 
Color Space ...............................................30 
Color Wheel ..............................................34 
Custom Mode ............................................25 
 
D 
Default Mode.............................................25 
Deleting Images.........................................20 
 
E 
Exposure Compensation............................33 
 
F 
File Types ............................................30, 43 
 
G 
Gray Balance ....................................... 34-35 
 
H 
Highlight control .......................................33 
Histogram ..................................................36 
 
I 
Image Information Window ......................41 
Images .............. 14, 19, 20, 28-30, 31-36, 41 
 Adjusting........................................ 31-36 
 Copying................................................14 
 Deleting................................................20 
 Information ..........................................41 
 Locking ................................................20 
 Marking................................................20 
 Processing ...................................... 29-30 
 Renaming .............................................19 
 Resolution ............................................30 
 Rotating................................................20 
 Saving ............................................ 28-29 
 Selecting...............................................19 
Installing SIGMA Photo Pro .......................7 

SIGMA Photo Pro User Guide  45 





II NN DD EE XX    

J 
JPEG image ...............................................43 
 
L 
Locking Images .........................................20 
 
M 
Magnification Loupe ........................... 23-24 
Main Window..............................................3 
Marking Images.........................................20 
Monitor....................................................7, 9 
 Resolution ..........................................7, 9 
 Verification ............................................9 
 
N 
Navigation Pane ........................................17 
 
P 
Processing and Saving Images ............ 27-30 
 Processing Groups of Images...............28 
 Processing Individual Images ..............29 
  
R 
RGB Values ..............................................34 
Renaming Images ......................................19 
Resolution..................................................30 
Review Window .........................................4 
Rotating Images.........................................20 
 
S 
Saturation control ......................................33 
Saved Settings ...........................................38 
Saving Images ..................................... 28-29 
 For Print ...............................................43 
 For Web ...............................................43 
 Saving Groups of Images.....................28  
 Saving Individual Images.....................29 
Selecting Images........................................19 
Settings ................................................25, 38 
 Saving ..................................................38 
 Deleting................................................38 
Shadow control..........................................33 
Software ............................................ 7-8, 12 
 Auto-Launch ........................................12 
 Installation..............................................7 
 Drivers ...................................................8 
 Removal .................................................7 
 System requirements ..............................7 
 
T 
Thumbnail .................................................18 
 Filtering................................................18 
 Size.......................................................18 
 Sorting..................................................18 
 Viewing with Details ...........................18 
Thumbnail Pane.........................................16 
TIFF image ................................................43 

SIGMA Photo Pro User Guide  46 





II NN DD EE XX    

SIGMA Photo Pro User Guide  47 

T continued 
Tonal Adjustments ....................................33 
 Contrast ................................................33 
 Exposure compensation .......................33 
 Highlights.............................................33 
 Saturation .............................................33 
 Shadows ...............................................33 
 
W 
Warning Mask ...........................................36 
White Balance ...........................................37 
 
X 
X3F image ...............................12, 14, 17, 19 
 

 
 

 
  
 




	Please Read Before You Start
	
	Trademark Acknowledgements


	Table of Contents
	1 Introduction
	1.1 About SIGMA Photo Pro
	What you can do in SIGMA Photo Pro; A quick visual tour
	Main Window elements
	Review Window elements

	1.2 About this manual
	Symbols and conventions
	Navigating the on-screen version of the manual


	2 Computer Set-Up
	2.1 Installing the software
	Windows system requirements
	Macintosh system requirements…
	Installing and uninstalling software…
	Installing camera drivers…

	2.2 Setting up your monitor
	Verifying monitor brightness, gamma, and color
	Using a pre-existing monitor profile
	Choosing the best monitor resolution for your screen size


	3 Before You Begin
	3.1 Connecting the camera to your computer
	Connecting the cables
	Turning on the camera
	Switching from battery to AC power
	Connecting the camera while the application is running

	3.2 Launching the software
	Opening and closing SIGMA Photo Pro
	Enabling and disabling Auto-Launch


	4 Transferring Images
	4.1 Transferring images from the camera to your computer
	Using the Copy Camera Images button
	Using a CF Card reader to copy images to your computer


	5 Managing Images
	5.1 Main Window Overview
	Main functions
	Links to more information
	Changing the size of the Main Window
	Changing the size of the Navigation and Thumbnail Panes

	5.2 Displaying images in the Main Window
	Viewing images stored on the camera
	View images stored on your computer

	5.3 Different ways to view thumbnails
	Changing the size and style of thumbnails
	Sorting and filtering thumbnails

	5.4 Renaming Images
	Renaming images outside of SIGMA Photo Pro

	5.5 Selecting images
	Selecting one image
	Selecting multiple images

	5.6 Marking, Locking, & Rotating images in Main and Review Windows
	Rotating images
	Marking and unmarking images
	Locking and unlocking images

	5.7 Deleting images in the Main or Review Window
	Deleting images


	6 Reviewing Images
	6.1 The Review Window
	Opening a Review Window
	Main functions
	Links to more information

	6.2 Navigating through a folder using the Review Window
	Choosing which image is displayed in the Review Window
	Using Navigation Buttons to select images
	Selecting specific images from the Main Window

	6.3 Using the Magnification Loupe
	Turning the loupe on and off
	Changing the magnification of the loupe
	How to read the RGB values in the loupe
	Restoring the loupe

	6.4 Viewing Images with Highlight and Shadow Warnings
	Using masks to analyze highlights and shadows

	6.5 Using the Adjustment Mode Settings
	Default Mode: Reviewing images with default adjustments (to match in-camera preview)
	Auto Mode: Reviewing images with automatic adjustments (dependent on image content)
	Custom Mode: Reviewing images with a specific setting applied
	Unsaved Settings

	6.6 Multiple Review Windows
	Opening Multiple Review Windows
	Using multiple Review Windows to compare images
	Using multiple Review Windows to compare modes


	7 Processing & Saving
	7.1 Main Window Processing
	Processing groups of images simultaneously
	Processing directly from the camera to the computer

	7.2 Review Window Processing
	Processing individual images
	Applying the current unsaved setting
	Choosing a destination

	7.3 Processing options
	File type
	Resolution
	Adjustment Settings
	Color Space


	8 Adjusting Images
	8.1 Using Adjustment Controls to manually adjust images
	Opening and closing the Adjustment Controls Palette
	Maximizing, minimizing, and closing the palette

	8.2 Making Tonal Adjustments
	Exposure
	Contrast
	Shadow
	Highlight
	Saturation
	Sharpness

	8.3 Making Color Adjustments
	Using the Color Wheel
	Using the Color Wheel to manually adjust color
	Using the Color Adjustment Eyedropper to adjust color

	8.4 Using the Histogram and Warning Masks
	Reading the Histogram
	Enabling, disabling and setting values for the Warning Masks

	8.5 Changing White Balance
	Changing the White Balance setting on an X3F file

	8.6 Saving and applying custom settings
	Applying settings from the Adjustment Controls Palette
	Saving settings
	Deleting settings


	9 Getting Image Info
	9.1 Image information
	Image information in the Main and Review Windows
	Image information in the Thumbnail Pane
	Image information in the Camera and Computer Panes

	9.2 Accessing the Image Information Window
	The Image Info Button
	The Image Information Window


	10 Appendix
	10.1 Supported file types
	TIFF format
	8-bit versus 16-bit TIFFs
	JPEG format
	Deciding which format to use

	10.2 Choosing resolution
	Choosing resolution

	10.3 Camera references
	Setting camera date and time
	Battery warnings


	Index
	A
	C
	D
	E
	F
	G
	H
	I
	J
	L
	M
	N
	P
	R
	S
	T
	W
	X


